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1. Revision History 

The following modifications to this release note have 

been made relative to the note provided with the 

CodeWarrior for Power Architecture Processors v10.5.1 

installation: 

 

Date Description 
Jan 25, 2016 Initial version 

Jan 28, 2016 Updated supported devices 

 

An updated version of this document is available on 

CodeWarrior for Power Architecture Processors product 

support page.  

2. About this release 

2.1. Version information 

This release note provides important information for 

users of CodeWarrior Development Studio for Power 

Architecture Processors. You are encouraged to read 

this document to become familiar with this release’s 

supported targets, new features, errata with 

workarounds, and other useful information. 
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The v10.5.1 release delivers Linux QorIQ SDK 1.9 compatibility, integrates support for several new 

devices, and introduces several new product features. Highlights of the release are included below. 

 

- Compatibility with SDK 1.9 for Linux kernel, application, and module debugging  

- Build tools alignment with SDK 1.9 

- Possibility to change RCW source location  

- Enabled multi-core halt groups for B4x targets 

- Performance analysis support for T1023, T1024, and T1042  

 

 

Most of the features described in this document are new relative to the last general availability release, 

CodeWarrior Development Studio for Power Architecture Processors v10.5. 

2.2. Licensing 

This release is distributed under an End-User License Agreement. The EULA is displayed during 

product installation and a copy is located in the layout in the PA/License folder. Please read the contents 

of the document carefully before using this product.  

  

v10.5.1 release has the same license with v10.5 therefore a license upgrade is not necessary when 

transitioning from v10.5. A license upgrade is required though when transitioning from v10.4 or earlier 

versions. Customers can obtain a license, if needed, by exercising the options listed in the Software 

Licensing section of the Freescale account. 

 

Please consult http://www.freescale.com/cwregister for additional information regarding license 

registration and activation, or enter a service request with Category = “Software Product and Topic = 

“License Issue”. 

 

When used for evaluation purposes CodeWarrior will generate a temporary license valid for 15 days 

from installation date. Please note that the generated license certificate is node-locked to the machine 

running the installer; evaluation on multiple machines requires separate installs. 

 

Past expiry, external users can solicit an evaluation extension by opening a licensing SR – please see 

section 2.4. The license certificate (license.dat) needs to be placed in the CW_PA/PA/ folder. 

2.3. Getting Help 

Product documentation is included with the layout, available for off-line from the Documentation folder 

in the link above, or from Freescale Infocenter. 

 

If you have questions, issues, or want to provide feedback, please use the Freescale online support web 

page. To use this page, follow these steps: 

1. In a web browser, go to http://www.freescale.com/TechSupport. 

Freescale’s Technical Support web page appears. 

http://www.freescale.com/infocenter/index.jsp?topic=%2Fcodewarrior_processors%2FQorIQ.html
http://www.freescale.com/TechSupport
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2. On this page, click the Submit a service request online link. 

The New Service Request — Category/Topic page appears. 

3. From the Category dropdown menu, select Technical Request. 

4. From the Topic dropdown menu, select CodeWarrior (or other appropriate topic). 

5. Click Next. 

The New Service Request — SR Details page appears. 

6. In this page, enter the requested information.  

At a minimum, enter information in each field marked by an *. 

7. Click Submit. 

If you are already logged in, the Service Request Confirmation page appears. Go to the last step. 

If you are not already logged in, the Log-in page appears. 

8. If you are a registered member, login with your user name and password. 

The Service Request Confirmation page appears. Go to the last step. 

9. If you have not yet registered,  

a. If you want to become registered member, click Register Now and complete the registration 

process.  

The Service Request Confirmation page appears. 

b. If you do not want to register, supply your contact information in the I do not want to register - 

Provide contact information form and click Submit. 

The Service Request Confirmation page appears. 

10. Click Done. 

Your service request is submitted. 
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3. System Requirements 

CodeWarrior Host 

 

 Windows® OS: Intel® Pentium® 4 processor, 2 GHz or faster, Intel® Xeon™, Intel® Core™, AMD 

Athlon™ 64, AMD Opteron™, or later 

 Linux® OS: 1.8 GHz Intel® Pentium® class processor (or better).  

 At least 2 GB of RAM 

 At least 3 GB of free disk space. 

 Free USB port for use with installation media. 

 Internet connectivity for web downloads and update access. 

 

Operating System 

 

Windows 

Host OS SP Level 32-bit 64-bit 

Windows 7 SP1 X X 

Windows 10   X 

Linux 

Host OS Version 32-bit 64-bit 

Ubuntu 14.04 X X 

Fedora 22  X 

Debian 8.2  X 

openSUSE 13.2  X 

Mint 15  X 

CentOS 7.0  X 

RedHat Enterprise Linux  6.5 
 

X 
 

 

NOTE CodeWarrior installation on 64-bit Linux hosts requires presence of dependent 32-bit 

libraries in the system. For supported distributions the installer detects missing 

dependencies and provides options to install them automatically. 

 

Some other Linux distributions may be used, but would require some manual identification 

and installation of the missing, required libraries. 

 

It is required that all product maintenance operations be done with administrative privileges. 

 

CodeWarrior installer may update system drivers for probe connectivity. It is highly 

recommended that any CW-PA versions or products are closed before installing or updating 

an existing CW. 

 

Microsoft has ended support for Windows XP. Freescale recommends that all customers 
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upgrade their operating systems as recommended by Microsoft. 
 

  



 

Release Contents 
 

 

CodeWarrior Development Studio for Power Architecture Processors v10.5.1  

6 Freescale Semiconductor 

 

 

4. Release Contents 

This section describes the main product features in this general availability release (v10.5.1). 

4.1. New Devices Supported 

All the devices supported in the service packs on top of previous release v10.5 are supported and 

integrated in 10.5.1. Changes comparing to v10.5 are highlighted in red. 

 
Device 
Name 

Device 
Revision 

Board Type Bare 
Metal 
Debug 

Linux 
Debug 

Nexus  
Trace 

Performance 
Analysis 

T1023 1.0 RDB-PC rev D Yes Yes Yes Yes 

T1013 1.0 RDB-PC rev D Yes Yes Yes Yes 

BSC9132 1.1 QDS rev H Yes No  NA No 

MSC8323 1.1 MDS Yes  No  NA No 

T1020 1.1 RDB-PA Yes Yes No No 

T1022 1.1 RDB-PA Yes Yes No No 

T1024 1.0 QDS/RDB rev C Yes Yes Yes Yes 

T1014 1.0 QDS/RDB rev C Yes Yes Yes Yes 

T1042 1.1 RDB-PA Yes Yes Yes Yes 

 

Complete list of IC/boards supported is available on product web page.  

 

 

NOTE “Linux Debug” implies Linux Kernel, Module, and Application Debug capabilities. 

 

“Bare Metal Debug” implies U-Boot debugging out of NOR flash, register and memory 

access, board initialization and flash programming for the flash device on the board.  

 

 

4.2. Update Sites  

v10.5.1 release can be complemented with additional features and service packs after install. The 

following updater sites are available in the update advisor (Help>Install New Software).  

 

CodeWarrior for Power Architecture Processors Updater Sites 

FSL PA Eclipse Update Site 
Main CW-PA product updater site that will be used for 

publishing future service packs. 

FSL PA Build Tools Build tools update channel 

http://www.nxp.com/products/software-and-tools/software-development-tools/codewarrior-development-tools/suite-for-networked-applications/codewarrior-development-studio-for-power-architecture-technology-eclipse-v10.5:CW-PA?tid=redCW_DSPA
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FSL PA QCVS QorIQ Configuration and Validation Suite channel 

FSL PA Packet Tools Packet Analysis Tool update channel (coming soon) 

4.3. IDE 

This release is based on Eclipse 3.7.1. Several fixes/improvements were added since previous release 

v10.4. 

 

Some updates and fine tunings were done on the IDE side: 

- New option is available to align simple declarations in columns. This can be enabled as follows: 

Window -> Preferences -> C/C++ -> Code Style -> Edit... -> Check "Align simple declarations in 

columns". 

- Support to export/import file-specific compilation macros from one project to another using a 

simple text-based export format. 

- Added support to generate preprocessed files for all source files in a project. 

- Users can adopt another name for the "Referenced Systems" folder which stores the xml files 

describing the debug target and connection. For this to happen, a new variable (-

Dcom.freescale.core.ide.rse.foldername=<new_name>) must be set in <layout>/eclipse/cwide.ini 

file, <new_name> representing the desired name for the folder. 

- A Browse button was added in File > Open Path... > Find and Open File dialog box to enable a 

faster navigation to the required file. 

- Ability to add project include paths relative to the most appropriate variables. 

- Added support in ‘CodeWarrior Executable Importer’ to import multiple cores. 

- Path/File requestor is now used consistently in all dialogs. 

4.3.1. Usage Notes and Limitations 

 

Ubuntu Themes  
CodeWarrior UI (Flash Programmer in particular) may display incorrectly if the host OS is Ubuntu 

10.x/12.x accessed over a remote connection (ie. VNC). Changing the host OS desktop theme to 

anything but Ambiance or Radiance has been found to alleviate the issue.  

 

OpenJDK incompatibility  
OpenJDK is not supported by CodeWarrior. Users are advised to either install an Oracle Java Virtual 

Machine, or use the one bundled with CW.  

 

4.4. Build Tools 

This release version includes GNU GCC for Power Architecture version 4.9.2- r1267. 

 

Changes since previous release: 

- Updated source base to binutils v2.25. 
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- Updated source base to glibc v2.20. 

- Updated source base to newlib v2.2.0. 

- Ported all patches and library optimizations to glibc v2.20. 

- e5500 32-bit memset: Replace 64-bit ld/std instruction usage with 32-bit lfd/stfd/stw instructions. 

- e6500 32-bit memset/memcpy: Replace 64-bit ld/std instruction usage with 32-bit lwz/stw 

instructions. 

- Fix GCC linux command line driver to pick soft-float libraries automatically while generating 

static binaries. 

- Fix 32-bit CDE machine RHEL build (older kernel) segmentation fault when the tool chain is run 

on fedora machine (latest kernel). 

- Configure binutils to handle/enable plugin support (required to build static libraries with LTO). 

 

NOTE GCC 4.8.2 continue to be available as service pack and can be installed via Eclipse updater 

(like any previous build tool service pack) by selecting: 

FSL PA Build Tools  

 

Switching between version of toolchain feature is available only at project level by 

changing the default toolchain (Project -> Properties -> Build Tool Versions) after the 

service pack with the desired version of the build tool was installed. 

 

4.5. Documentation 

Product documentation is available in several formats: 

- Integrated with the help system of the Eclipse IDE 

- In the product layout in PDF format (CW_PA/PA/Help/PDF/) 

- Freescale Infocenter 

 

Getting Started Guides 
Use these document to quickly get started with setting up boards, creating & debugging projects, 

collecting the trace data, or installing a service pack.  

 

Power Architecture Processors CodeWarrior Getting Started Guide (Updated) 

Explains how to install the CodeWarrior software, prepare the boards supported by the current release, 

and then create, build, and debug a simple project 

 

CodeWarrior for Power Architecture Processors - Quick Start (Updated)  

Explains how to install CodeWarrior Development Studio for Power Architecture Processors and how to 

create and debug a simple project. 

 

Using the Ethernet TAP Probe - Quick Start  

Explains how to set up the Ethernet TAP probe and create, build, and debug a simple project that uses 

this device. 

 

Installing Service Pack for CodeWarrior Tools - Quick Start (Updated) 

http://www.freescale.com/infocenter/index.jsp?topic=%2Fcodewarrior_processors%2FQorIQ.html
http://www.freescale.com/infocenter/index.jsp?topic=%2Fcodewarrior_processors%2FQorIQ.html
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Explains how to install a service pack or an update for your CodeWarrior software running on the 

Windows platform. 

 

CodeWarrior IDE - Quick Reference Card  

Lists keyboard shortcuts and defines the purpose of major CodeWarrior IDE user interface elements. 

 

Application Notes 
 

Several Application Notes are available describing how to accomplish some of the commonly needed 

development tasks. Please check the Documentation tab of CW-PA product support web page regularly 

for new Application Notes.  

 

Application notes are not included in the product build but they are available for download form 

CodeWarrior for Power Architecture Processors product support page.  

 

User Guides 
 

Use these documents to learn how to perform what to perform, solve the most common problems using 

the FAQs guide, or simply learn more about the built-in features.  

 

Targeting Power Architecture Processors (Updated)  

Explains how to use the CodeWarrior development tools to develop software that targets the Power 

Architecture processors; includes examples, definition of target-settings panel options, and a debugging 

tutorial. 

 

CodeWarrior for Power Architecture Processors - Frequently Asked Questions  

Provides answers to the most frequently asked questions about the CodeWarrior IDE and the Power 

Architecture tools. 

 

CodeWarrior Common Features Guide (Updated)  

Describes the CodeWarrior IDE and debugger features that are common across all the CodeWarrior 

products. 

 

Power Architecture Simulator User Guide  

Describes the software simulation models released with CodeWarrior Development Studio for Power 

Architecture Processors. 

 

CodeWarrior TRK Reference  

Describes CodeWarrior TRK and explains how to customize it for use with different hardware 

configurations. 

 

Power Architecture Build Tools Reference  

Explains how to use CodeWarrior tools to build programs. 

 

Tracing and Analysis Tools User Guide (Updated)  

http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&nodeId=0152102726E4C7E4CF&fpsp=1&tab=Documentation_Tab#nogo
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Explains how to use the tracing and analysis tools to analyze the performance of your programs. 

 

EWL C Reference  

Documents the CodeWarrior implementation of the C standard library. 

 

EWL C++ Reference  

Documents the CodeWarrior implementation of the C++ standard library. 

 

MSL C Reference  

Explains how to use the MSL C standard library. Use this library with the GCC build tools. 

 

MSL C++ Reference  

Explains how to use the MSL C++ standard library. Use this library with the GCC build tools. 

 

CodeWarrior TAP Users Guide  

Explains how to set up the CodeWarrior TAP debug probe so it can communicate with the debugger and 

the target hardware. 

 

Gigabit TAP Users Guide  

Explains how to set up the Gigabit TAP debug probe so it can communicate with the debugger and the 

target hardware. 

 

USB TAP Probe Users Guide  

Explains how to set up the USB TAP debug probe so it can communicate with the debugger and the 

target hardware. 

 

Ethernet TAP Probe Users Guide  

Explains how to set up the Ethernet TAP debug probe so it can communicate with the debugger and the 

target hardware. 

 

Cheat Sheets 
Use these cheat sheets to complete moderate-to-complex tasks by following instructions that you 

execute real-time within the CodeWarrior IDE.  

 

Select Help > Cheat Sheets in CodeWarrior IDE to see and run one of the available cheat sheets. 

4.6. Debugger 

4.6.1. Supported Probes  

The following debug probes are supported in this release:  

- External USB TAP (UTAP)  

o Not supported for, T104x QDS/RDB, T102x QDS/RDB, T101x QDS/RDB 

- External Ethernet TAP (ETAP)  
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o Not supported for, T104x QDS/RDB, T102x QDS/RDB, T101x QDS/RDB 

- CodeWarrior TAP / USB  

- CodeWarrior TAP / Ethernet  

- Gigabit TAP (GTAP)  

- Gigabit TAP (JTAG only) + Aurora (trace) 

 

NOTE Freescale has discontinued the support for USBTAP and ETHTAP starting with general 

available release v10.3.3 (3 years ago) but they have continued to be available for older 

setups. Supporting newer parts (i.e. T1040 and newer) is not possible due to technical 

limitations. CWTAP (over Ethernet or USB) is the recommended probe. 

 

 

 

4.6.2. New Features  

 

Debugger alignment with SDK 1.9 (Linux Kernel 3.12.37)  

The debugger was updated and verified for Linux Kernel Debug and Linux Application debug to work 

with latest version SDK 1.9. 

 

Enabled multi-core halt groups for B4x targets 

The debugger now supports multi-core halt groups for B4x targets. The level of support is similar to that 

existing on T4240 target, which was already supported in previous versions. 

 

Improved stepping performance during Linux debug 

A step takes a lot of time when more than one thread is targeted for a core because the entire thread list 

is read from the target. Now the thread list is read only when necessary. 

 

Possibility to change RCW source location  

This improvement is applicable to most QorIQ targets. 

4.6.3. Usage Notes and Limitations 

For kernel module debugging, the breakpoints which are set in a module are not enabled the second time 

the module is inserted if “Cache Symbolics Between Sessions” isn’t checked. As a workaround remove 

and set again the breakpoint. 

 

After debugging several times a SMP project, debug operation might fail with the following error: 

“Invalid input value”. The workaround would be to restart CW. 

 

For e6500 cores any cache operation on L2 Cache from Cache Viewer window works only for the 

cluster that includes the current selected core. The workaround is to select from Debug View a core from 

the L2 cluster on which you want to perform a cache operation. 
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An error occurs at reading cache data on shared caches from a secondary core when the first core is 

running. The workaround is to stop all the cores that share the same cache before performing any cache 

operation on that cache. 

 

The initialization and memory files for u-boot provided with CodeWarrior are not kept in sync with the 

latest SDKs and some variations on the initializations (values of RCW usually) might be present. The 

user needs to update those files in order to debug u-boot successfully on latest SDK versions.  

 

SMP debug is not recommended to be used in SRAM configuration as usual SMP applications are larger 

than SRAM size. The use case is however present but it is totally into the user responsibility to make 

sure SRAM size is not overrun. 

 

During testing we have noticed a performance penalty when stepping during Linux module debug 

operations. Occasionally we have noticed a delay of several seconds between successive steps depending 

on the probe/setup and number of cores. 

 

PLL overwrite is no longer supported. All comments related to PLL override were removed from 

CodeWarrior JTAG config files. 

 

Debugger Limitations for G4/B4 device families  
The following features are not supported for the B4 device families:  

- Breakpoint cross-triggering  

- Reset Configuration Word override  

 

Debugger Limitations for T4 device families  

 

The following features are not supported for the T4 device families:  

- Breakpoint cross-triggering  

 

For the T4240 rev. 1 QDS in particular, please note that the Reset Configuration Word cannot be fetched 

from NOR flash. This is a hardware limitation.  

 

The factory FPGA image shipped with T4240 Proto3 boards is incompatible with CodeWarrior 

(ENGR00234909). Symptoms of the incompatibility include:  

- A faulted core immediately after reset  

- Inability to stop the platform immediately after reset  

- Stepping failures immediately after reset  

- Inability to use the Flash Programmer  

Proto4 boards do not exhibit any of these issues. Proto3 users are advised to upgrade the FPGA image to 

a version later than T4240QDS_1011_1755_release 

 

For schematics rev D5 board the reset delay must be enabled and set for at least 2000 ms. 

 

Secure Debug (P4080)  
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If you provide a wrong key and an unlock sequence is run by the debugger with the erroneous key, the 

associated part will be locked permanently and you will need to reset the target to connect again.  

 

Stepping limitations in low-power states on P4080  
The Doze and Nap core states are reported by CW while target is in one of the two power management 

states. When resuming (either run or step) the core will get back in the same state. While the debugger is 

able to detect and display the low-power state of the target even if running, it is not recommended to use 

step operation while being in any of these two states. Please note that on P4080 Rev 1 low power states 

don't work reliably.  

 

 

Debugger compatibility with TightVNC  
* Debugger fails to start in Linux machine if Tight VNC is running. You can workaround this problem 

by downloading rgb.txt from  

http://cvsweb.xfree86.org/cvsweb/xc/programs/rgb/rgb.txt and copying it to /etc/X11/rgb.txt 

Additional information here: https://lists.ubuntu.com/archives/ubuntu-uk/2007-April/004337.html.  

 

Debug over Aurora  
The GigabitTAP probe can be reliably used with CodeWarrior in the following scenarios:  

- Run control over the JTAG interface  

- Trace extraction over JTAG interface  

- Trace extraction over Aurora interface  

 

Although partially functional on B4860 targets, debugging over Aurora interface has known stability 

issues and is therefore not supported.  

 

Import Elf Wizard Limitations  
A dtb file cannot be imported within the wizard and the user has to do this from GUI. Also SMP cores 

cannot be selected. 

4.7. B4/T4 Instruction Set Simulators 

 

No significant updates were done on the simulators. 

4.7.1. Usage Notes and Limitations 

Following limitations are currently known: 

1. B4860ISS: LAW configuration can be done only via configuration file, at initialization time, not 

at runtime 

2. B4860ISS: The PA side is implemented but not fully verified. 

3. T4240ISS is supported currently only in Linux64 

4. The Linux images were not updated to the latest available by Freescale 

5. 5. B4860 SoC reset - not supported, need to restart the simulation 
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ENGR00237053 - [SC10.4.4] B4860ISS cores are not able to restart separately in multicore 

debug scenario 

6. B4860 e6500 core reset - not supported 

7. T4240 hardware breakpoints not supported (ENGR00232437) 

8. Watchpoints issues with the CW for PA: 

MTWX52001 - [B4860ISS/e6500] Watchpoints with Read or Read/Write attributes don't trigger 

MTWX52700 - [B4860ISS] Only watchpoints of thread#1 are hit in a multicore scenario 

MTWX52836 - [B4860ISS] Watchpoints on float variables are not hit 

9. Other known issues: 

ENGR00236321 [Multicore] crcpe test on multi-core fail 

ENGR00274258 [SDOS Use Cases] [multicore, iterations=1, debug/release] maple_eTVPE 

demos get stuck 

4.8. Software Analysis 

No significant features have been added in software analysis components in v10.5.1 release. However, 

several issues were addressed since last release. Please consult the list of Fixed Issues at the end of the 

document. 

4.8.1. Usage Notes and Limitations 

Trace collection over Aurora is not functional for B4420.  

Performance Analysis is not yet available for T1023/T1013. 

 

P2040/P2041 Aurora Trace Collection 
Currently due to an issue while training Aurora probe the collection of trace over Aurora does not work 

for P2040/P2041 without a workaround. 

Following steps must be taken to train correctly the Aurora probe and be able to collect the trace: 

1. Start a debug session using JTAG and select the train_aurora.tcl init file in the connection 

settings. Make sure that you select the correct jtag config file. 

2. After the board stops at the start of main file, open the Debugger Shell window by selecting 

Window > Show View > Debugger Shell, and run the following command (similar to the 

reset_to_user command run from CCS console: protocol ccs::reset_to_user 

3. Reset the probe from telnet and wait for the CCS connection to re-establish. 

4. Terminate the current session from CodeWarrior and debug again. 

5. Complete description of the Aurora training sequence for P2040/P2041 is available in Tracing 

and Analysis Tools User chapter 2.4 Preparing Aurora Interface for Collecting Aurora Nexus 

Trace. 

4.9. New Project Wizard and Import Wizard 

The New Project Wizard and Import Wizard allow generation of sample C/C++ projects for all devices 

supported by the product. In this release the wizards have been updated to include all devices listed in 

section 4.1 New Devices Supported 
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In wizard pages the user is able to configure and enable build, debug, and software analysis settings. 

4.10. Installer 

The installer must be run as root due to the CW dependency install mechanism. However, if the installer 

is not started as root it will inform the user about this requirement. 

 

The installer now tries to automatically install the dependencies required by CodeWarrior to run. In case 

of a failure the user is directed to the README.txt file which describes the steps needed to manually 

install the dependencies. 

 

The installer now automatically starts in console mode instead of failing in case the GTK2 32bit libraries 

are missing (this was a common issue occurring on 64bit host operating systems) and it tries to install 

them during the dependency install phase. 

 

The GUI installer is now mapped 1 to 1 with the console mode. This means that all the screens present 

in the GUI installer are also present in the Linux installer 

4.10.1. Usage Notes and Limitations 

Using CodeWarrior on 64-bit Linux Hosts  

To run the installer in graphical mode on 64-bit Linux Hosts the 32-bit GNU libc and Xorg libraries 

must be installed, otherwise the setup will start in console mode. Please consult the README file 

accompanying the installer for per-distribution instructions 

5. Fixed Issues 

The following defects present in previous product errata have been addressed by this release. The list 

includes mainly exceptions in previous release as the real number of defects fixed is considerably higher. 

 

Debugger/CCS 

DTDBGPG-54 [P1020RDB-PD][Linux Kernel debug] Incorrect stack when stopped at kernel 

entry point 

DTDBGPG-444 CodeWarrior NAND Flash programmer algorithm cannot work on T1040RDB 

DTCCS-39 Add a configurable option for  socket connect wait time in CCS command 

DTCCS-99 Cross triggering isn't implemented for T1024 and T1040 boards (QDS and RDB) 

DTCCS-74 Ability to retrieve CCS server version from CCS API 

DTCCS-5 CCS failed to open CWTAP-USB on linux machines having udevadm version 209 

or above 

DTCCS-32 A memory read with j2i2cs gives wrong values  

DTCCS-17 [B4] fsldbg_trigger_event_state does not halt the cores 

DTDBGPG-478 [PA] Possible crash when suspend all if more than 32 threads were targeted 

DTDBGPG-323 [PA10.5.1][T1040RDB-PA][SPI flash] Blank Check failed when 'Erase All Sector 
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Using Chip Erase Command' option is checked 

DTDBGPG-18 [CW PA 10.5.1]Update readme with correct revision for T1023/T1013 

  

Software Analysis 

DTSA-359  [PA 10.5.0] [Trace commander view] Trace Commander view doesn't trigger 

automatic refresh after trace reconfiguration 

DTSA-354 [PA10.5.0][SP1] Error: java.lang.NullPointerException when choose 

Linux_Application_Attach in Debug Configurations 

DTSA-710 [PA10.5.1][MulticoreTrace][B4] Error if master core is not core0 

DTSA-352 [PA10.5.0+SP1]No trace was collected with multicore trace DDR Overwrite 

Automatically 

  

Build Tools 

NTR  

IDE 

NTR  

Documentation 

NTR  

6.  Known Issues 

 

Please consult the latest version of this document for the accurate list of known issues, available on 

CodeWarrior for Power Architecture Processors product support page.  

 

The following defects are known to be present in this release. Wherever applicable, the workaround is 

listed below defect description. 
 

 

Debugger/CCS 

ENGR00361611 [T1040QDS] Lock/Unlock don't work 

 

Workaround: None 

 

DTDBGPG-377 

[PA10_MRD4773] RCW override on T2080RDB 

 

Workaround: Use board switches to hardcoded RCW. 

ENGR00291107 [T4240QDS rev 2]Error after debug SMP several times 

 

Workaround: Workaround is to restart CodeWarrior. 

ENGR00274128 B4 full RCW override is not working 

 

 Workaround: RCW can be written in the flash. 

DTDBGPG-56 [T4240QDS][L2Cache] Debugger shown data of L2 Kibo caches of all clusters are 

as well as data of the cluster that Debug view is focusing 

http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&nodeId=0152102726E4C7E4CF&fpsp=1&tab=Documentation_Tab
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Workaround: A cluster can be disabled if a core for that cluster is selected and 

the disable operation is performed. In debug view selection of the current core 

has to be done to be able to perform the operation.  
 

ENGR00358673 [SDK1.8][Linux 64bit host] Cannot load module symbolics (no error message 

when user doesn't have permission to access a file) 

 

Workaround: The user should verify the permission access for mounted driver. 

We recommend to use NFS vers3 instead of cifs (Samba) for Linux OS.  

e.g.  

mount -t nfs -o vers=3 <from_IP>:<from_folder> <to_folder> 

 

The user must add nounix,noserverino options to your smbfs/cifs mount options for 

Linux 64bit host. 

e.g. 

mount -t cifs /<from_IP> <to_folder> -o 

username=<userID>,nounix,noserverino 

ENGR00360393 [Freescale compiler][P1022DS][BFPP] Can not read _ldouble variable in  

 

Workaround: Look directly in the SPE registers where the variable is stored 

DTDBGPG-58 [AppTRK][e5500-64b] Sometimes threads can't be created after hardware 

breakpoints/watchpoints were hit 

 

Workaround: This is a kernel issue. It looks like the issue is caused by DBSR 

register which is not cleared in kernel after the hardware breakpoint/watchpoint is 

hit by the application. 
1. Use step over (source stepping) when hardware breakpoint/watchpoint is hit 
2. All hardware breakpoints/watchpoints should be disabled before 

pthread_create 
3. Restart AppTRK before any session  

For watchpoints, the only solution is to patch the kernel but the patch isn't 

currently available 

 

DTWIZ-76 
[CW PA 10] Linux kernel attach launch problems. 

 

Workaround: Adjust debug settings after they are created 

  

Build Tools 

DTDBGPG-493 
[PA10.5.1]Build fail with project T2080QDS|C|64b|ROM 

  

IDE 

NTR  

Software Analysis 

ENGR00301151 Can't decode SPID Linux trace result 

http://sw-jira.freescale.net/browse/DTDBGPG-493
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Workaround: None 

DTSA-858 

DTSA-859 

Trace support for T1020 and T1022 is not enabled in SA GUI 

 

Workaround: None 

  





 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
How to Reach Us: 

Home Page: 

www.freescale.com 

E-mail: 

support@freescale.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

 

 
CW-PA-RN 
 
29 January 2016 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
IInformation in this document is provided solely to enable system and software implementers to use 
Freescale Semiconductor products. There are no express or implied copyright licenses granted 
hereunder to design or fabricate any integrated circuits or integrated circuits based on the information in 
this document. 
 
Freescale Semiconductor reserves the right to make changes without further notice to any products 
herein. Freescale Semiconductor makes no warranty, representation or guarantee regarding the 
suitability of its products for any particular purpose, nor does Freescale Semiconductor assume any 
liability arising out of the application or use of any product or circuit, and specifically disclaims any and 
all liability, including without limitation consequential or incidental damages. “Typical” parameters that 
may be provided in Freescale Semiconductor data sheets and/or specifications can and do vary in 
different applications and actual performance may vary over time. All operating parameters, including 
“Typicals”, must be validated for each customer application by customer’s technical experts. Freescale 
Semiconductor does not convey any license under its patent rights nor the rights of others. Freescale 
Semiconductor products are not designed, intended, or authorized for use as components in systems 
intended for surgical implant into the body, or other applications intended to support or sustain life, or for 
any other application in which the failure of the Freescale Semiconductor product could create a 
situation where personal injury or death may occur. Should Buyer purchase or use Freescale 
Semiconductor products for any such unintended or unauthorized application, Buyer shall indemnify and 
hold Freescale Semiconductor and its officers, employees, subsidiaries, affiliates, and distributors 
harmless against all claims, costs, damages, and expenses, and reasonable attorney fees arising out of, 
directly or indirectly, any claim of personal injury or death associated with such unintended or 
unauthorized use, even if such claim alleges that Freescale Semiconductor was negligent regarding the 
design or manufacture of the part. 
 
Freescale, the Freescale logo, CodeWarrior and ColdFire are trademarks of Freescale Semiconductor, 
Inc., Reg. U.S. Pat. & Tm. Off. Flexis and Processor Expert are trademarks of Freescale  
Semiconductor, Inc. All other product or service names are the property of their respective owners 

 
  

©2016 Freescale Semiconductor, Inc. All rights reserved 

 
 

 


